
Unit- III : MS Excel 

 

1. What is excel? what are the features of Ms- Excel ? 

Microsoft excel is an integrated electronic spread sheet program developed by Microsoft corporation. 

It is a core part of Microsoft office Package. It includes the following features. 

a) Autocalc: This feature is very useful to sum a group of numbers is selected them. Their sum 

will automatically appear in the status area. 

b) Auto complete: Excel now intelligence to anticipate what you are going to type! Based 

upon entries you’ve already made, AutoComplete will try to figure out what you intended to 

type, once you’ve entered few letters. 

c) Autocorrect: Excel can support automatically correct mistakes. These include the same 

features you’ve used in word and you can create your own AutoCorrect entries. 

d) Better Drag-and-Drop: Do you want to move a group of cells? Excel’s drag and drop 

feature lets you reposition selected portion of your spreadsheet by simply dragging them 

with your mouse. 

e) Cell tips and Scroll Tips: To help you get around better with mouse, Excel now includes 

scroll tips. When you click and drag a scroll bar, a small window tells you what row or 

column you are heading for. 

f) Number Formatting: It’s easy to format numbers with excel’s new number formatting 

feature. Select your numbers and choose cells command from format menu. 

g) Templates and Template wizard: Excel’s template facility has been greatly enhanced. You 

can choose from a variety of elegantly designed templates for your home or business. You 

can even have a template wizard link your worksheets to a database. 

h) Shared Lists: you can now have worksheets that are shared simultaneously over a network. 

 

2. What are the part of the Excel window? 

The following basic window appears when you start the excel application.  

a) The Ribbon 

The Ribbon is designed to help you quickly find the commands that you need to complete 

a task. Commands are organized in logical groups, which are collected together under tabs. 

Each tab relates to a type of activity, such as formatting or laying out a page. To reduce 

clutter, some tabs are shown only when needed. For example, the Picture Tools tab is 

shown only when a picture is selected. 

 



b) File Menu 

Here you will find the basic commands such as open, save, print, etc. 

c) Quick Access Toolbar 

The place to keep the items that you not only need to access quickly, but want to be 

immediately available regardless of which of the Ribbon's tabs you're working on. If you put 

so many items on the Quick Access Toolbar that it becomes too big to fit on the title bar, 

you can move it onto its own line. 

d) Formula Bar 

A place where you can enter or view formulas or text. 

e) Expand Formula Bar Button 

This button allows you to expand the formula bar. This is helpful when you have either a 

long formula or large piece of text in a cell. 

f) Worksheet Navigation Tabs 

By default, every workbook has 3 sheets. You are able to navigate the sheets by clicking on 

the sheet tab. 

g) Insert Worksheet Button 

Click the Insert New Worksheet button to insert a new worksheet in your workbook. 

 

 

 

 



3. Explain the terms Workbook ,Worksheet and Cell. 

WORKBOOK :  

 A workbook automatically shows in the workspace when you open Microsoft Excel XP. Each 

workbook contains three worksheets. 

WORKSHEET : A worksheet is a grid of cells consisting of rows and columns. 

Spreadsheet information—text, numbers, or mathematical formulas—is entered into different cells. 

 

 Column headings are referenced by alphabetic characters in the gray boxes that run across the 

Excel screen, beginning with column A.  

 Rows are referenced by numbers that appear on the left and then run down the Excel screen. The 

first row is named row 1. 

The cell : 
 

An Excel worksheet is made up of columns and rows. Where these columns and rows intersect, 

they form little boxes called cells 

 

4. How to Create, Open and Save a Workbook 
Excel files are called workbooks. Each workbook holds one or more worksheets (also known as 

spreadsheets). 

To create a new blank workbook: 

a. Click on the office button. 

b. Select New. 

c. Select Blank workbook under Available Templates. It will be highlighted by default. 

d. Click Create. A new blank workbook appears in the Excel window. Shortcut key : CTRL+N 



To open an existing workbook: 

a. Click on the office button. 

b. Select Open. The Open dialog box appears. 

c. Select your desired workbook, then click Open. [ OR ] Shortcut key : CTRL+ O 

To save a workbook 

Following are the steps to save an edited excel sheet – 

a. Step 1 − Click the File tab and select Save As option. 

b. Step 2 − Select a folder where you would like to save the sheet, Enter file name, which you 

want to give to your sheet and Select a Save as type, by default it is .xlsx format. 

c. Step 3 − finally, click on Save button and your sheet will be saved with the entered name 

in the selected folder. [ OR ] Shortcut key : CTRL+ S 

5. How to Insert and Delete rows and columns ?  

To inset row 

a. Select the row below where you want the new row to appear. 

b. Click the Insert command on the Home tab. 

c. The new row appears in your worksheet. 

To insert column 

a. Select the column to the right of where you want the new column to appear. For example, 

if you want to insert a column between A and B, select column B. 

b. Click the Insert command on the Home tab. 

c. The new column appears in your worksheet. 

To delete row 

a. Select the rows you want to delete. 

b. Click the Delete command on the Home tab. 

c. The rows are deleted from your worksheet. 

To delete column 

a. Select the columns you want to delete. 

b. Click the Delete command on the Home tab. 

c. The columns are deleted from your worksheet. 



6. How to  Enter and edit  formulas in Excel? 

a) Entering Formulae 

 You can enter a formula into any cell in your worksheet. Follow these steps: 

 Click the cell where you want to enter a formula. 

 Type an equal sign(=) to begin a formula. 

 Type the formula and press the enter key. The result of the formula is stored in the cell 

where the formula is written. 

 To view the formula you entered, click in the formula bar. This formula for the cell appears 

in the formula bar. 

To edit formula, follow these steps. 

 Double – click the cell containing the formula you want to change the formula. The formula 

appears in the cell 

 Press the <- or - > key to move the insertion point to where you want to remove or add 

characters. 

 To remove the character to the left of the insertion point, press the BACKSPACE KEY 

 To add  data where the insertion point flashes on your screen, type the data 

 When you finish making changes to formula, press the ENTER KEY 

7. How to Adjust row height and column width  

To change column widths 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click Column Width. 

4. In the Column width box, type the value that you want. 

 To Change Row Height 

1. Select the row or rows that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click Row Height. 



4. In the Row height box, type the value that you want. 

8. How to Format cell values ?  

It is very common to enter various types of numbers for various applications. In Excel, you can use 

number formats to change the appearance of numbers, including dates and times, without changing 

the number behind the appearance. The number format does not affect the actual cell value, it 

changes the appearance only. 

1. Select the cell or cells which contain numbers. 

2. On the home tab, under Number group click on down arrow mark. 

 

 

Or Right click your mouse; from the short hand menu select format cell option. 
 

3. It launches Formula cells window. Click on Number tab. 

4. It lists all categories of number formatting like general, number, currency, accounting, date, 

time, and percentage. 



5. Select the suitable format and its sub options, click ok button. 

6. The numbers in the selected cells will display as per new format. 

 

9. Explain about Cell references in formulas 

A cell reference refers to a cell or a range of cells on a worksheet and can be used in a 

formula so that Microsoft Office Excel can find the values or data that you want that formula to 

calculate. 

There are three types of cell references 

 

1. Relative cell reference 

2. Absolute cell reference 

3. Mixed cell reference 

Relative Cell References 

 The row and column references can change when you copy the formula to another cell 

because the references are actually offsets from the current row and column.  

 By default, Excel creates relative cell references in formulas. 

 

Absolute Cell References 

 The row and column references do not change when you copy the formula because the 

reference is to an actual cell address.  

 An absolute reference uses two dollar signs in its address: one for the column letter and one 

for the row number (for example, $A$5). 



 

Mixed Cell References 

 A mixed reference has either an absolute column and relative row, or absolute row and 

relative column. 

 An absolute column reference takes the form $A1, $B1, and so on. 

 An absolute row reference takes the form A$1, B$1, and so on 

 If the position of the cell that contains the formula changes, the relative reference is changed, 

and the absolute reference does not change. 

 If you copy or fill the formula across rows or down columns, the relative reference 

automatically adjusts, and the absolute reference does not adjust. 

10. Explain Different types of functions available in Excel 

A function is a predefined formula that performs calculations using values indicated in a particular 

order. MS Excel has many built in functions, which we can use in our formula. 

Mathematical Functions 

o SUM - Adds up all the values in a range 

o ROUND - Round a number to a specified number of digits  

o CEILING - Round a number up to a multiple of significance 

o FLOOR - Round a number down to a multiple of significance 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers 

o POWER – Returns the power value of the given number. 

o Sin,Cos & tan – Returns the trigonometric values of the given number 



Text Functions 

 LOWER(text) − Converts all characters in a supplied text string to lower case 

 UPPER(text) − Converts all characters in a supplied text string to upper case 

 TRIM − Removes duplicate spaces, and spaces at the start and end of a text string 

 CONCATENATE(text 1,text 2…) − Joins together two or more text strings. 

 LEFT(text,num_chars) − Returns a specified number of characters from the start of a 

supplied text string. 

 MID(text,start_num,num_chars) − Returns a specified number of characters from the middle 

of a supplied text string 

 RIGHT (text,num_chars) − Returns a specified number of characters from the end of a 

supplied text string. 

 LEN (text)− Returns the length of a supplied text string 

 FIND(findtext,within_text,start_num) − Returns the position of a supplied character or text 

string from within a supplied text string (case-sensitive). 

Statistical Functions :  

 MAX − Returns the largest value from a list of supplied numbers. 

 MIN − Returns the smallest value from a list of supplied numbers. 

 AVERAGE − Returns the Average of a list of supplied numbers. 

 COUNT − Returns the number of numerical values in a supplied set of cells or values. 

 COUNTIF − Returns the number of cells (of a supplied range), that satisfies a given criteria. 

 SUM − Returns the sum of a supplied list of numbers 

Date & Time Functions 

o DATE  : This function takes three parameters : the year,month and day. It returns the serial 

number of the particular date. Syntax : Date (year, month, day) 

o Day : This function returns the day of the month (a number from 1 to 31) corresponding to a 

serial number represents a date. 

Syntax : Day(serial_number) 

Hour : This function returns the hour, an integer from 0 to 23 corresponding to a serial 

number.Syntax : Hour (serial_number) 



o Month : This function returns the month, an integer from 1 to 12 corresponding to a serial 

number. 

Syntax : Month (serial_number) 

TIME − Returns a time, from a user-supplied hour, minute and second. 

Syntax : Time(hour,minute, second) 

o SECOND – This function returns the second corresponding to serial_number 

Syntax : second (serial_number) 

o Today  − This function returns the serial_number that represents today’s date 

o NOW − Returns the current date & time, based on your computer’s internal clock. 

 

Logical Functions  

 AND − Tests a number of user-defined conditions and returns TRUE if ALL of the conditions 

evaluate to TRUE, or FALSE otherwise 

 OR − Tests a number of user-defined conditions and returns TRUE if ANY of the conditions 

evaluate to TRUE, or FALSE otherwise. 

 NOT − Returns a logical value that is the opposite of a user supplied logical value or 

expression i.e. returns FALSE if the supplied argument is TRUE and returns TRUE if the 

supplied argument is FALSE 

11. How to create Filters in MS Excel ? 

Filtering data in MS Excel refers to displaying only the rows that meet certain conditions. (The other 

rows gets hidden.) 

To create filters in excel are : 

 Place a cursor on the Header Row. 

 Choose Data Tab » Filter to set filter. 

 Click the drop-down arrow in the Area Row Header and remove the check mark from Select 

All, which unselects everything. 

 Some of the row numbers are missing; these rows contain the filtered (hidden) data. 



 There is drop-down arrow in the Area column now shows a different graphic — an icon that 

indicates the column is filtered. 

Using Multiple Filters 

 You can filter the records by multiple conditions i.e. by multiple column values. 

12. Explain about Sorting in Ms- Excel? 

Sorting data in MS Excel rearranges the rows based on the contents of a particular column. You may 

want to sort a table to put names in alphabetical order. Or, maybe you want to sort data by Amount 

from smallest to largest or largest to smallest. 

To Sort the data follow the steps mentioned below. 

 Select the Column by which you want to sort data. 

 Choose Data Tab » Sort Below dialog appears. 

 

 If you want to sort data based on a selected column, Choose Continue with the selection or 

if you want sorting based on other columns, choose Expand Selection. 

 You can Sort based on the below Conditions. 

o Values − Alphabetically or numerically. 

o Cell Color − Based on Color of Cell. 

o Font Color − Based on Font color. 

o Cell Icon − Based on Cell Icon. 

 Clicking Ok will sort the data. 



13. What is a chart? Explain different types of charts? 

Chart is graphical representation of numerical data. It improves the analysis and understanding of the 

data. Excel offers both two dimensional and three dimensional charts. Some common chart types 

are: 

1. Column chart: comprises the values across the categories and displays them in vertical bars. 

2. Bar chart: It also comprises the values across the categories but displays them in horizontal. 

3. Pie chart: It displays the contribution of each value for a total value. 

4. XY Scatter chart: compares the values in pairs. 

5. Scattered chart: It displays the trend of contribution of each value over time or categories. 

6. Rader chart: It marks at each point. 

7. Surface chart: It shows trends in values across two dimensions in continuous curves. 

8. Bubble chart: It is similar to scattered chart, it compares 3 set of values, the third value 

displays at the size of the bubble marker. 

9. Stock chart: It requires 3 or 4 series of values to represent volume, high, low, close. 

10. Cylinder chart: It is similar to column chart instead of bars it displays values as cylinder. 

11. Cone chart: It is similar to column chart instead of bars it displays cones. 

12. Pyramids chart: It is similar to column chart; Instead of bars it displays pyramids. 

14. How to create Charts in Excel? 

To create charts for the data by below mentioned steps. 

 Select the data for which you want to create the chart. 

 Choose Insert Tab » Select the chart or click on the Chart group to see various chart 

types. 

 Select the chart of your choice and click OK to generate the chart. 



 

Editing Chart 

You can edit the chart at any time after you have created it. 

 You can select the different data for chart input with Right click on chart » Select data. 

Selecting new data will generate the chart as per the new data, as shown in the below screen-

shot. 

 

 You can change the X axis of the chart by giving different inputs to X-axis of chart. 

 You can change the Y axis of chart by giving different inputs to Y-axis of chart. 

15. Explain about Auto fill feature in Ms- excel? 

The auto fill feature allows you to quickly fill cells with repetitive or sequential data such as 

chronologicl dates or number and repeated text. 

 



Filling text series : 

 Not only you can fill a range with a text, number or formula,but you enter also can do it with a 

series. Perform the following steps to fill a test series: 

 Enter the text you want to start the series. 

 Click the cell containing the text you entered. 

 Position the mouse pointer over the fill handle. 

 Drag the mouse pointer(+) over the cells you want to include in the series. 

Filling text series : 

 Excel completes a number series based on the numbers in the first two cells. These numbers 

tell excel how much to add to each number to complete the series. 

16. What is a macro? How can you record and run a macro in excel? 

 Macro : A macro is a series of commands and functions that are stored in a Microsoft visual 

basic module and can be run whenever you need to perform a task. Regularly repeating activities can 

be automated by using macro. 

Recording a macro or creating a macro : 

1. Click on the worksheet in which can you want to create a macro. 

2. Click on record macro from code group under Developer tab, record macro dialog box 

appears on the screen 

3. Type a macro name in macro name box: assign any shortcut key , later it can be used by using 

shortcut key. 

4. The shortcut must be letter. It is optional.  

5. Click on ok button. 

6. Make your activities like formatting text, typing text etc.,if you want to stop recording click on 

stop recording from code group under Developer tab. 

Running a macro: 

1. select a macros from code group under Developer tab, excel displays the macro dialog box. 

2. Select macro name from macro name:box 

3. Click on RUN Button 



17. Explain about Using Templates in MS Excel 

Template is essentially a model that serves as the basis for something. An Excel template is a 
workbook that’s used to create other workbooks. 

Viewing Available Templates 

1. To view the Excel templates, choose File » New to display the available templates screen in 
Backstage View.  

2. You can select a template stored on your hard drive, or a template from Microsoft Office 
Online. 

3. If you choose a template from Microsoft Office Online, you must be connected to the Internet 
to download it.  

4. The Office Online Templates section contains a number of icons, which represents various 
categories of templates.  

5. Click an icon, and you’ll see the available templates. When you select a template thumbnail, 
you can see a preview in the right panel. 

 

On-line Templates 

1. These template data is available online at the Microsoft server.  

2. When you select the template and click on it, it will download the template data from Microsoft 
server and opens it as shown below. 
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